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CEO’s Message 

Dear readers, 

 

Building Information Modelling (BIM) has gained much traction in recent   

years as digital construction technology that will fundamentally transform 

the building and construction industry practice in the delivery of an  

excellent built environment. It is a game changing technology that will 

improve the construction productivity as well as the level of  

integration and collaboration across the various disciplines in the  

construction value chain. It is therefore important for the  

industry to embrace the technology with clarity. 

 

The BIM Essential Guides are part of the industry’s efforts to demystify BIM and to give clarity 

on the requirement of BIM usage at different stages of a project.  

  

Under the leadership of the BIM Steering Committee chaired by Er Lee Chuan Seng, Emeritus 

Chairman, Beca Carter, and comprising of leaders in BIM, the BIM Managers Forum has 

contributed much time and effort to compile the various best practices to make this Guide 

possible over a short span of time. We would like to thank them for their contribution.  

 

We hope that every BIM user can truly reap the benefits of BIM by integrating it into his/her 

day-to-day workflow – from feasibility study to facility management. We hope that BIM users 

can use these guides as a platform to jumpstart their BIM adoption, before they leap to 

greater heights, innovating and transforming their workflow. 

 

BIM is a journey. We envisage that it will grow with time and will inspire more advanced and 

innovative use of BIM. I would like to encourage all BIM practitioners to join in this industry 

effort to grow this Guide into a wealth of BIM knowledge.  

 

Dr John Keung 
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OBJECTIVES 

The objective of this Guide is to assist MEP (Mechanical, Electrical and Plumbing) BIM users to 

develop BIM model(s) for new or and A&A project. It shows the possible use-cases of BIM at 

various design stages of the project. 

This is a general document that covers a few typical buildings and is not an extensive 

document that covers all scenarios that might arise based on specific projects. Users are 

allowed to edit/change accordingly to suit their needs. 

This document is not based on any specific software. This document does not cover the 

explanation and steps on how to use the software. For the steps and explanations of specific 

software, please refer to the software help or user manual. 

Based on the project requirement, type and time line choose the BIM use and implement in 

the project. 
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Suggested Deliverables 

 

STAGE SUGGESTED DELIVERABLES (MEP ONLY) 

 

1. Preparation & Conceptual 

Design 

a. Understanding Client’s Requirements 

b. BIM Execution Plan 

c. MEP Concept Report which includes simple 

schematic, relevant design codes and etc.   

2. Schematic Design a. Preliminary Model based on Architectural massing 

models 

b. MEP Schematic Design Report which includes design 

criteria and prelim design calculation.  

c. Schematic Drawings 

3. Detailed Design a. Detailed Design Drawing + Model 

b. MEP Detailed Design Report which includes updated 

design criteria and design calculation 

c. Clash detection & resolution report between MEP 

model and Architect & Structure models  

d. Detailed cost estimate, BOQ, tender documents 

 

4. Construction N/A 

 

5. As Built N/A 

6. Facility Management           N/A 

    

 

 

 

Note: Regulatory BIM e-submissions are excluded from the above list because the timing of submission may vary 

due to individual project requirements.  
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Preparation & Conceptual Design 

 
UNDERSTANDING CLIENT’S REQUIREMENTS 

 Identify project brief 

 Identify sustainability aspirations 

 

Both the client and project team should reach an understanding on the purpose of BIM to 

fulfil Client’s Requirements.  

 
 

Example questions to clarify the Client’s Requirements. 

 

 What are the overall goals in this BIM 
project? 
 

 What are the specific goals that have to be 
achieved by BIM in this BIM project? 
 

 What are the possible ways to achieve the 
specific BIM goals? 
 

 Is the client aware and agreeable that the 
design team may use a different way to 
achieve the specific BIM goals? 

 

The preliminary BIM MEP Model can be created from the Architectural BIM model and serves 

as a preparation for the Detailed Design stage.  Before starting the actual modelling, it is 

recommended to go through proper planning and preparation.  
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PROJECT SET-UP 

Factors to be considered before starting a BIM Project:  

 Client’s requirements as stated in the BIM execution plan  

 Agreed software platform and version for the project  

 

Typical Project Set-up Workflow 

 

Legend:  AR – Architectural Model 

  ST – Structural Model  
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Load Template  

Load MEP BIM Template before the start of a new project. The template should include 

company standards from the following 4 MEP sub-disciplines: 

 Air-Conditioning and Mechanical Ventilation ACMV (Services)  

 Plumbing and Sanitary Services  

 Fire Protection Services  

 Electrical Services  

 

Project Information 

Each project file should include the following project information: 

 Project Status  

 Client Name 

 Project Address 

 Project Name 

 Project Number 

 Project location 

 Other optional project information: e.g. Design Engineer etc.  

 

Building Services Additional Data: 

 Building Services type  (i.e. VAV – Single Duct)  

 Building Construction  (Defines default Building Construction)  

 Building Infiltration Class (Defines Building Construction leakage)  

 Report Type   (Defines type of Analysis report generated)  

 Ground Plan   (Project level associated to Site Ground level) 

 Project Phase  (Defines what phase of the project is being analyzed) 

 Sliver Space Tolerance  (Defines riser and shaft tolerances for the space) 
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ARCHITECTURAL MODEL VALIDATION 

Check the coordinate of the Architectural model. Make sure both MEP and Architectural 

models has the same coordinate before linking. The basic elements required from the 

Architectural model are as follows: 

 

 

 Raised Floor 

 False Ceiling 

 Grids 

 Levels 

 Plumbing Fixtures 

 Slab 

 Wall 

 Services, Risers 

 The elements should be placed realistically on the architectural plan 

for proper modelling of required MEP systems 
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Example for Revit MEP BIM Users  

 

1) Load project template 

 

 
 

An example of MEP template can be found at  http://bimsg.wordpress.com/singapore-

guide/e-submission/ . It is designed for MEP BIM e-submission. 

  

2) Link architectural model 

 

 

 

 
 

Note: Using Origin to Origin Positioning option to place MEP model at the same position as 

the Architectural model  

 

 

 

http://bimsg.wordpress.com/singapore-guide/e-submission/
http://bimsg.wordpress.com/singapore-guide/e-submission/
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Preparing MEP Model  

Make sure that the MEP and Architectural levels are aligned. This can be done through the 

following steps for Revit MEP users. 

a. Open one of the elevation views of the model by 

right–clicking and select Go to Elevation View  

  

b. Open the Modify Tab of the select Align tool. Pick the Architectural model level (a) first, 

then pick the MEP Level to align (b). See below.  

 
 

c. Lock the MEP level to the AR level by clicking the 

Lock Icon that appears in the view. This is to 

monitor any future changes to the floor height of 

the project 

 

 

 

Sheets Set-up  

Basic title blocks and sheets are already created as part of BCA MEP e-Submission Template.  

New sheets can be created through the following steps:  

a. Go to View Tab and select Sheet  

  
b. Choose the right Title Block to be used for the new sheet  
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Modelling Plan  

A project model should be carefully divided into manageable sizes based on the project 

complexity or size. This can be done through Worksharing and Linking Models for Revit Users. 

 

Worksharing  

This is applicable for bigger projects that need to be done by more than one BIM modeller. The 

Worksharing function must be enabled.  

Work Sharing Workflow  
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Members could name the file they are working on with the following naming convention.  

 

WORKSET NAME ELEMENTS ASSIGNED TO WORKSET 

ES Electrical sub-discipline elements SN Sanitary sub-discipline elements 

FP Fire sub-discipline elements PL Plumbing sub-discipline elements 

ACMV Mechanical sub-discipline elements PF Plumbing Fixture sub-discipline 

elements GAS Gas sub-discipline elements 

 

Linking Models  

This is the most common method for projects where the individual models of each sub-

discipline in a project are created. This is more applicable for smaller projects where tasks can 

be done without too much coordination effort. Elements will be placed in the model and can 

be coordinated within the sub-discipline itself. Models will then be linked for coordination 

with other sub-disciplines within the central file.  

Linking Model Workflow  
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STARTING THE MODEL  

Once the project set-up has been done, file will copied for each sub-discipline.  

 

Coordinating MEP Elements Using Link 

Individual sub-discipline models will be linked one by one to a Central File. The linked models 

cannot be edited inside the Central File. They need to be edited in the original authoring tool. 

Relinking of the files using Mange Link is needed to reflect the latest update back in the 

Central File.  

 

Specifying Pipe/Duct Settings 

Create a new pipe/duct type. Configure conversion settings that will be used when creating a 

pipe to physically connect the elements. Types of pipes/ducts to be created will be based on 

the requirements of the project. 

Pipe settings to be done are shown (but not limited to) below: 

a. Pipe Types (Materials, Fittings and other accessories, etc.) 

b. Pipe Sizes 

c. Systems 

Pipe types Setting 
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Schematic Design 

 

SCHEMATIC DIAGRAMS 

 

The Schematic Design Stage for Mechanical, Electrical and Plumbing covers the steps required 

for creating schematic diagrams. BIM modelling is not required.  

Most BIM authoring tools do not have the capability to generate Schematic Diagrams 

automatically from the model at this moment. It is recommended to follow either one of the 

options below to generate Schematic Diagrams 

1. Create Schematic Diagrams using traditional 2D methods in a CAD environment 

2. Create Schematic Diagrams using BIM authoring tools  

 

 Sample Plumbing Services Schematic Diagram 
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TRADITIONAL 2D METHOD USING CAD TOOLS 

Schematic diagram created in CAD tool can be loaded directly into BIM tools through the 

following steps 

1. Create a new sheet from the View Tab of BIM Authoring Tools  

2. Select the tile block based on the system from the list of the title blocks shown in the 

New Sheet dialog box. 

3. The created new sheet for the schematic diagram will be placed under the non category 

views on the project browser. Right click on the created sheet and rename it based on 

the purpose of the model.  

 

 

 

 

4. Insert the pre-created 2D CAD drawing through Insert Tab – Link CAD then choose the 

intended file as show in the image on below  
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BIM METHOD 

 

It is advisable to import the symbols and typical details that are already created in CAD. This is 

to save time in creating the schematic diagrams. Below are steps needed to create the 

schematics in BIM.  

 

1. Creating a new Drafting View 

from the View Tab.  

View > Drafting View 

2. Import 2D Symbols through 

Insert Tab > Import CAD (a and b 

from the figure on the left) 

 

3. Place the imported 2D Symbols 

into the drawing and connect it. 

Using the Detail Lines. 

Use Annotate Tab c and use Detail 

Line tool d to do.  

 

4. Select the lines e from the figure 

on left) that were created and 

change the line style properties 

to its representing system. f 
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Analysis 

PREPARING BIM MODEL FOR ENERGY ANALYSIS  
 

Visualization 

Survey the model to determine the best method of installing MEP systems. 

 Perform walkthrough  

 

 Cut Sections (2D / 3D) 
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Setting Project and Zone Information 

Set a data that is universal to the project, including building types, location, weather, building 

construction type, and window type data. 
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Creating and Defining Rooms or Spaces 

Assign spaces to the linked Architectural model and make sure that all spaces are properly 

assigned including unoccupied spaces such as plenums and shafts.  
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Form ACMV Zones to group spaces created earlier  

 

 

Input spaces’ detail information by using either property palette or space schedule and make 

sure all the spaces are correctly defined. All spaces need to be defined even unconditioned 

spaces like plenums and shafts  
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Enter detail information for zones and spaces. Make sure that all spacing errors and warning 
are solved before proceeding to next step. Any error or warning left unsolved may affect the 
accuracy of the analysis.  

 

Loads Calculation 

Cooling load calculation results can be produced in three types: Simple, Standard and Detail. 
The report can be accessed in the Project Browser under reports 
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 Analyze the reports 

 

 

In order to further perform energy analysis by using other energy analysis software, export 
gbXML file from BIM modelling authoring tools.  
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SIZING MEP ELEMENTS 

 

Creating Diffusers and Mechanical Equipment  

Choose the right diffusers and equipment based on the design requirements 

Place the diffusers and equipment in the model. 

 

Duct Layout 

Complete the ACMV systems with ducts. 
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 Select the system to be sized. 

 

 Set the friction loss rate. 

 Set the duct height restriction if necessary for some factors e.g. ceiling space 

limitation. 
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 Run Duct Sizing 
 

 
 

 Generate and analyze the duct pressure loss report. 
 

 
 

 

 Do some changes to the model if necessary. 
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Detailed Design 

In the Detailed Design stage, the preliminary design model will be further developed with 

more accurate BIM elements. Additional BIM elements need to be added to complete the 

model. Refer to Appendix A for a list of typical BIM elements with attributes that need to be 

modelled. Elements should come with an accurate dimensions, shape and location. Necessary 

attributes should be provided.  

Deliverables:  

1. Tender model with drawings  

Content: 

 Site Plans 

 Floor Plans  

 Schematic Diagrams  

 Typical detail Plans  

 BIM model  

 

2. Submission BIM model for Regulatory Approval  

Please refer to BIM MEP e-submission guides for specific requirements from the 

Agencies  

 

The sub-chapter will be divided into different services namely:  

 Mechanical Services   

 Electrical Services  

 Plumbing & Sanitary Services and  

 Fire Protection Services  
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MODELLING MEP SERVICES  
 

In this section, it is assume that the file has already been prepared and the modelling plan to 

be used by the team has already been decided.  

 

Copy Monitoring Elements of the Architecture Model  

Copy Monitor is a tool to ensure the changes in the model between different disciplines are 

properly communicated.   

Note: Coordinates are to be acquired from the Architectural model first before doing copy 
and monitor. 

Revit elements which can be copied / monitored 
 

ELEMENTS REVIT MEP 

Grids Yes 

Levels Yes 

Columns Yes * 

Floors incl. openings Yes * 

Walls incl. openings Yes * 

Air Terminals Yes ** 

Lighting Fixtures Yes ** 

Plumbing Fixtures Yes ** 

  

*  Unless there is a specific project deliverable, this 

function should not need to be used in Revit MEP 

** If the element is created in the Architectural Model   
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Copy monitoring can be done through the following steps:  

a. On the plan view of the model, go to the Collaborate 

Tab and select Copy/Monitor tool  

 

 

b. From the pull down menu, choose Select Link 

c. Hover the cursor to the architecture link model and pick 

it. Copy monitor tab will be activated.  

 

d. Select Copy from the ribbon then select the elements intended to copy and monitor 

on the project (a). 

e. Click Finish (c ) once done  

Additional MEP elements will be created on the same position of the copied 

architectural model.  

 

Note: If there is a change in the updated Architectural Model affecting the elements that 
have been copied and monitored, a warning will appear on the screen once the updated 
Architectural Model is being reloaded. 

 

After the project has been set up, the mechanical services can be modelled in the manner 

illustrated in the following pages. 
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Modelling Mechanical Services 
(Source: BCA Academy) 

 
 

Architectural / 

Structural Model 

 

Placing Mechanical 

Equipment   

 

Modelling The 

System    
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Modelling Electrical Services 
(Source: ST AE) 

 

Architecture Model  

 
 

Placing Electrical 

fixtures, equipment 

and Lighting fixture 

and devices  

  

Modelling the Cable 

trays and Ladders  
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Modelling Plumbing and Sanitary Services 
(Source: Rankine & Hill) 

 

Architecture model and 

Structural Model  

 

 
Insert and Place all the 

required Plumbing Fixtures in 

there correct location.  Make 

sure that all the Plumbing 

Fixtures has their connector 

with corresponding Piping 

System type. 

 

 

Decide where the Floor Trap 

and Floor waste should be  
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Create the connection 

between the Floor 

Trap/Waste  and Plumbing 

Fixtures   

 

Create the Main Sanitary 

Pipe routing and connect 

it to the riser  

 
 

Create the vent pipe routing  
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Create Plumbing pipe 

routing   

 

Check if there are clashes 

between two Piping 

Systems.  

 

Typical Floor, Copy 

Plumbing & Sanitary routing 

to above level for further 

coordination.  
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After Coordination, Copy the 

typical plumbing   & sanitary 

routing to other typical floors 

and connect the riser to each 

other for it to become one 

connected piping system.   
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Modelling Fire Protection Services 
(Source: xx) 

  

Hide all unnecessary elements 

from Architecture model. 

  

Determine Zone 
Requirements  

To know the number of 
sprinklers to be place in a 
particular space of the building 
it is important to zone the 
areas using the linked 
architecture model.  

 

Creating Sprinkler Schedule  

After zoning has been done, 
sprinkler schedule can be 
easily created using the 
information derived by the 
zones. 
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Placing Fire Protection Equipments 

All fire protection equipment shall be placed 
on the architecture model in realistic position. 
Local regulations must be considered such as 
distances, elevations, locations, etc 

 
 
 

Modelling connections  

Pipe shall be place and routed according to 
the design with correct sizes and levels. 
Complete with fittings and accessories. 

 

 

Modelling Sprinkler Heads, 

Main Pipe and Branches  



BIM Essential Guide – For MEP Consultants 

 

33 

 

MODEL REFERENCING IN CONSTRUCTION DOCUMENTS  
 

This is the last step of the design development stage where the model will be prepared for 

regulatory submission or tendering. 

 

Objectives: 

 To extend the information of the model by putting additional properties such as 2D details 

and attributes. 

 

Deliverables: 

 Model for Tendering  

 Model for BIM e-Submission 

 

Preparing BIM model for Tendering and e-Submission  
 

The floor plans, sections and other drawings required for tendering can be generated directly 

from the BIM model. Reference should be made to the MEP BIM e-submission Guidelines in 

preparing drawings for regulatory approvals 

The steps on the following pages can be applied to MEP trades of the project.  
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Preparing Floor Plans  

Open typical floors of the created model. Zoom- in to one of the typical units and do the 

following steps.  

a. From view tab, select Callout. Right click to the selected Callout and Open the View  

b. From the Annotate tab, click Tag by Category and select the elements in the model 

 

Standard annotation/tags available in the template can be used to annotate the model.  

c. Complete the annotation in the model using Text tool and other detailing tool if 

necessary. See figures Below  
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Placing Drawing into Sheets  

Once the drawing views (plans, schematics etc) are clearly annotated, they can be organized 

and placed in sheets with the steps below: 

a. Create a sheet for the intended tender drawing. Company standards title block loaded 

into the template. Select the appropriate one.  

b. From the project browser, drag and drop the drawing to be placed. 

c. Once done, the drawing will be the same as the figure on the next page. 

 

Repeat the same procedures to produce the documents listed below: 

 Key Plans and Layout  

 Site Plans  

 Floor Plans  

 Models  
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Publishing Model and Drawings to Non-editable File Format 

Refer to BIM MEP e-Submission guideline to export/publish to DWF for regulatory submission  

Note: The drawings produced from the BIM model during the Detailed Design stage can 
form part of the tender documents together with other 2D detail drawings 

 

HYBRID METHOD: 2D connection details and 3D representation with generic objects. 

  
 

Model as a reference for the certain views in floor plan. E.g. Multiple elements stacked at the 

same place. 
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PUBLISHING MODEL FOR TENDERING/SUBMISSION 
 

 

 

1. Link Reference models and MEP model to Production Template. 

 

2. Production Template consists of matchline, dependant views, and scope boxes.  
 

a. Create matchline 

 

b. Create dependant views 

Link Models 

•MEP Model 
•Reference Models 

Production 

•Production Template 
•Submission Template 

Export 

•Tender Drawings 
•Submission Drawings 
and Models 
•Etc 

Matchline 



BIM Essential Guide – For MEP Consultants 

 

38 

 

 

c. Create scope box 

 

 

3. Link views to sheets. 

Matchline 
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4. Publish sheets. 
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Collaboration between MEP Sub-Disciplines  

 

Collaboration Elements within Building  

 

  Level by Level (Storey by Storey) 

  Room by room (Below Raised Floor)  

 Horizontal Space (Plenum) 

 Vertical Space (Core Shafts) 

   

 

Vertical space (Core Shafts) 

Horizontal Space (Plenum) 
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Collaboration Elements at outside of Building - Roof Top, external face of 

building, external works etc 

 

  Mechanical System - ACMV Equipment and distribution such like Cooling tower, AHU, 

Ducting, etc 

 Plumbing and Sanitary System - Pumps, water holding tanks, pool filtration 

equipment, Sump, sewage pit, grease and sand traps, etc 

 Fire Protection System – Fire sprinkler pumps, sprinkler tanks fire shutter, smoke 

curtains, piping system, etc  

 Electrical System – Transformer, Lifts, Switch boards, panel, cable trays, trucking 

containment, etc  

Example: 

Plenum levels may need to be inserted to appropriately define the Mechanical Zones. Light 

fixtures and air terminals may also be referenced to a ceiling plenum level.  

 Elements between Diffusers and Ceiling Lighting fixtures  

 Elements between Ducting runs and piping system or Cable trays or Light fixtures and 

Sprinkler head 

 Elements between Fire dampers and piping system  

 

 

 

At Roof Top 
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Others 

VALUE- ADDED SERVICES 

For detailed information, refer to Singapore BIM Guide 

REGULATORY SUBMISSIONS 

For detailed information, refer to MEP BIM e-Submission Guideline 

MODEL VERSION CONTROL 
 

As the project progresses, consequently is the model change. Model will change according to 

specific requirements needed in every stage. Few factors of having numerous model versions 

are as follows: 

• Design Change 

• Authority Submission and Re-submission 

• Model Update 

• Remote Office Locations 

Different model versions are certain. Managing these versions is the possible option that we 

may implement to avoid having it. Few recommendations listed below will help all project 

members to avoid confusion. 

Organized Folder Structure 

• To implemented office-wide.   

• Saving the specific file on their corresponding location will be helpful for all, and will also 

reduce the time spent in searching.  

• To avoid duplicating files on their own PC to avoid confusion when working.  

• “Backup”, “Superseded” or similar folder name where all backups/ outdated files are 

located.  

• “Archive”, “Published” or similar folder name where all copies of issued files are located.  
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• “Working”, “WIP” or similar folder name where only “one working model” (varies on 

project setup) is located. 

Keeping “One Working Model” 

• Project Server to serve as a central location of model, where every team member can 

access and work.  

• “Graphisoft BIM Server”, “Revit Server” or similar will allow two or more teams located in 

remote office locations to update their changes to one central file simultaneously. 

NOTE: RECOMMENDATIONS ARE NOT APPLICABLE TO ALL. THESE VARY DEPENDING ON 
PROJECT AND OFFICE REQUIREMENTS. 
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Appendix A – Typical BIM Elements by Discipline 

Kindly tick and write down the attributes of the selected elements on the table.  

(I) ARCHITECTURAL BIM ELEMENTS  

 Element 
Elements or Parameters needed by each 
non-Architectural discipline 

Site Model 

Site infrastructure within site boundary 

(roads, pavements, car park spaces, access and 
parking arrangements and surrounding land use) 

 

Street fire hydrant (only indication of locations 
necessary) 

 

Surface drainage (only indication of locations 
necessary) 

 

External drainage & underground drainage  

Hard landscaped areas within site boundary  

Planter boxes including sub-soil drainage systems  

Massing of adjacent buildings relevant to project  

Rooms /  

Spaces 

Room spaces, corridors, other spaces, plant and 
equipment  rooms (including designated use) 

 

Walls and  

Curtain Walls 

Interior / Exterior walls / Non-structural walls / 
Blockwork walls (Including finishes to identify if tiled 
/ painted / plastered) 

 

Curtain wall with mullions and transoms with true 
profile and window glazing units including shading 
devices 

 

Doors, 
Windows and  

Louvers 

Interior / Exterior doors  

Interior / Exterior windows  

Louvers  

Basic  

structure 

Beams (based on location and size indicated by the 
Structural Engineer) 

 

Columns (based on location and size indicated by 
the Structural Engineer) 

 

Roofs 
Roofs with overall thickness (including finishes & 
insulation) 

 

Ceilings 

Ceilings (without support sub-frames) including 
module arrangement, material choices and finishes. 

 

Hangars and sub-frames for ceilings  

Floors Horizontal floors  
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Sloped floors and ramps  

Floor finishes details including tiling, carpet, screed 
only 

 

Vertical  

Circulation 

Steps & stairs including risers, threads and railings 
including headroom clearance requirements 

 

Elevator shafts (without fit-out installations by lift 
contractor) 

 

 

Access ladders and catwalks  

Architectural 
Specialties  

and Casework 

Precast / Prefab / GRC / Fibreglass facades  

Railing & parapets, including mesh & metalwork  

Fixed Building Maintenance Units in their overall 
bulk form 

 

Schedules 
Schedules allowing information to be extracted 
from elements 

 

Fixtures and 
Equipment  

(with input 
from interior 
designers, 
specialist sub-
contractors, 
etc) 

Loose furniture including desks and computer 
workstations, casework (carpentry), including upper 
and lower cabinets 

 

Appliances such as in kitchen equipment  

Toilet fixtures, plumbing faucets 

 

 

 these elements may cause BIM models to become too big and unmanageable. 

 

(II) STRUCTURAL BIM ELEMENTS  

Element 
Elements or Parameters needed by each 
non-Structural discipline 

Foundations including piles, pile caps, tie / ground beams & footings  

Diaphragm walls & retaining walls  

Beams  

Columns  

Walls  

Slabs, including slab on grade and floating slab, recesses, curbs, pads 
and major penetrations 

 

Other types of transfer structure not mentioned above  

Stairs (steps, risers, threads, landings): all framing members and 
openings 
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Shafts and Pits (and openings)  

Precast & Prestressed concrete systems: all primary and secondary 
elements 

 

Temporary structures and platforms  

Concrete reinforcement details (Rebar), imbeds and cast-ins   

Steel frame structures including bracing systems   

Base plates, bolts, clip angles, fixings, etc.   

Connection details of structural steel members   

 

 these elements may cause BIM models to become too big and unmanageable. 

 

(III) CIVIL BIM ELEMENTS 

 Element 
Elements or Parameters needed by each 
non-Civil discipline 

Digital Terrain 
Model (DTM)  

3D surface based on topography that shows site 
conditions and building locations  

Include existing walkways, roads, curbs, ramps and  
parking lots etc 

 

Geology Report  
 

Soil investigation report (A BIM Model is not 
required) 

 

Utilities Model 
All points of connection for existing and new 
utilities within site boundary 

 

Rainwater & 
storm water 
pipe work 

Includes outlets, surface channels, slot channels 
and manholes  

 

Underground 
Public Utilities 

For drainage only 
 

Others 
Drains, canals, crossings, retaining walls, and 
underground harvesting tanks 

 

 
Underground electrical supply cables and sewer 
lines, IDA (telecom) line and Gas Lines. 

 

 

  Data of Digital Elevation Model to be provided by registered surveyors 

 Data of Geology Report to be provided by geotechnical engineers 
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(IV) ACMV BIM ELEMENTS 

 Element 
Elements or Parameters needed 
by each non-ACMV discipline 

ACMV 
Equipment 

Air Handling unit 
 

 Chiller unit  

 Variable refrigerant unit  

 Cooling Tower  

 Split-type indoor & outdoor air conditioning units  

 Exhaust or extract air fans  

 Fresh air fans  

 Other fans such as jet fans  

 Heat Exchanges for projects with District Cooling  

ACMV 
Distribution 

Exhaust air ducts (excluding hangars) 
 

 Fresh air ducts (excluding hangars)  

 Supply air ducts (excluding hangars)  

 Return air ducts (excluding hangars)  

 Transfer air ducts (excluding hangars)  

 Diffusers, air-boots, air grilles, air filters, registers  

 
Fire dampers, motorized dampers, volume control 
dampers, CO2 sensors, CO sensors 

 

Mechanical 
Piping 

Chilled water supply pipes including connections, fittings & 
valves 

 

 
Chilled water return pipes including connections, fittings & 
valves 

 

 
Condensate drain pipes including connections, fittings & 
valves 

 

Others 
Switch boards, control, BMS & DDC panels, BMS control & 
monitoring modules 

 

 Fan Coil unit  

 
Engineering Smoke Extract System (e.g. smoke curtains, 
ductless fans) 
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(V) PLUMBING AND SANITARY BIM ELEMENTS  

Element 
Elements or Parameters needed 
by each non-Plumbing and 
Sanitary discipline 

Pipe supports and brackets  
 

Pumps 
 

Control panels, monitoring and control sensors 
 

Plumbing BIM Elements only  

Fresh water piping, fittings, valves including hot & cold water pipe work with 
all plumbing equipment, sinks 

 

Water meters 
 

Storage, water holding tanks 
 

Pressure Vessels 
 

Underground Public Utilities for water supply 
 

Underground Public Utilities for drainage 
 

Grey water systems 
 

Pool filtration equipment 
 

Sanitary BIM Elements only  

Foul drainage, kitchen waste pipe work including floor drains, open trapped 
gullies, sealed trapped gullies and clean outs, vents and manholes 

 

Grease and sand traps 
 

Sump and sewage pits 
 

 

 these elements may cause BIM models to become too big and unmanageable.   
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(VI) FIRE PROTECTION BIM ELEMENTS  

Element 
Elements or Parameters needed 
by each non-Fire Protection 
discipline 

System piping, droppers, fittings, valves and sprinkler heads, sprinkler inlets, 
sprinkler control valve set, subsidiary valves, flow switches 

 

Pipe supports and brackets   

Fire alarm gongs & break glass unit  

Fire sprinkler pumps  

Sprinkler tanks  

Hydrants and hose reels (location of street fire hydrant determined by 
architects) 

 

Gas piping for suppression systems  

Heat or smoke detectors, control panels, monitoring and control sensors, 
pump panels, check meter positions 

 

Fire extinguishers  

Fire shutters & hoods above  

Smoke Curtains  

 

 these elements may cause BIM models to become too big and unmanageable.  

 

(VII) ELECTRICAL BIM ELEMENTS  

Element 
Elements or Parameters needed 
by each non-Electrical discipline 

Cable trays, trunking & cable containment, electrical risers, conduit, bus duct, 
power feeds 

 

Outlets, panels, wall switches, circuiting to devices, security devices, card 
access and “plug moulds” (socket points) 

 

HV & LV switch boards, switchgear, MCCB boards, MCB boards  

Transformers  

Light fittings & fixtures & housings for light fixtures  
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Conduit associated with access, data communication, security systems and 
electrical equipment 

 

Telecom equipment and computer racks  

Generators and exhaust flues including acoustic treatments  

Diesel tanks & fuel pipes  

Security system including CCTV camera, smart card system, door monitoring 
system 

 

Car park control system, barrier gates  

Equipment and associated installations maintained by public utility companies 
(including manholes / drawpits for the Power Grid) 

 

Earthing and lightning protection system  

Lifts, PA systems, BMS equipments including display panels (e.g. power 
consumption display) 

 

 

 these elements may cause BIM models to become too big and unmanageable.  

 

(VIII) GAS BIM ELEMENTS  

Element 
Elements or Parameters needed 
by each non-Gas discipline 

Gas piping and supply  
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Appendix B – Suggested Colour Coding for Modelling  
 

ACMV 
 

SYSTEM TYPE COLOR RED GREEN BLUE 

Supply Air 150 0 127 255 

Return Air 92 0 189 0 

Fresh Air 200 191 0 255 

Exhaust Air 34 129 64 0 

Primary Air 130 0 255 255 

Kitchen Supply Air 210 255 0 255 

Stair Pressurization Air 200 191 0 255 

Lobby Pressurization Air 200 191 0 255 

Toilet Exhaust Air 34 129 64 0 

Kitchen Exhaust Air 40 255 191 0 

Smoke Engineering Air 34 129 64 0 

Chilled Water Supply Pipe 55 129 129 86 

Chilled Water Return Pipe 55 129 129 86 

Refrigerant Pipe 55 129 129 86 

Condensate Drain Pipe 55 129 129 86 

Mechanical Equipment 32 189 94 0 

Motor Control Panel 32 189 94 0 

Supply Air Grille 151 170 212 255 

Return Air Grille 93 126 189 126 

Fresh Air Grille 201 234 170 255 

Exhaust Air Grille 35 129 107 89 

Primary Air Grille 131 170 255 255 

Kitchen Supply Air Grille 211 255 170 255 

Toilet Exhaust Air Grille 35 129 107 89 

Kitchen Exhaust Air Grille 41 255 234 170 

Fire Damper 244 129 0 31 

Motorized fire Damper 7 255 255 255 

Damper 7 255 255 255 

Access Panel 7 255 255 255 

ACMV Text 52 189 189 0 

Equipment Text 32 189 94 0 
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ELECTRICAL 

 

SYSTEM TYPE COLOR RED GREEN BLUE 

Normal Power Cable Tray/Trunking/Ladder 
(Hatch) 131 170 255 255 

Emergency Power/GSM/Security Cable 
Tray/Trunking/Ladder (Hatch) 80 63 255 0 

Telecommunication System (Tel/Data Scv) 131 170 255 255 

Power System 80 63 255 0 

Public System 80 63 255 0 

Lighting Fixture 241 255 170 199 

Lighting Fixture 71 212 255 170 

Lighting Circuit (Dashed Line Type) 51 255 255 170 

Lighting Circuit (Divide Line Type) 61 234 255 170 

Lighting Fixture 131 170 255 255 

Lighting Fixture 71 212 255 170 

Electrical Equipment 2 255 255 0 

Electrical Panel 80 63 255 0 

Electrical Power Bus-Bar Trunking 2 255 255 0 

Electrical Equipment (Centre Line Type) 2 255 255 0 

Cable TV Lead-In Pipes/ Underground Cables 230 255 0 127 

Security System/ Electrical Opening 141 170 234 255 

Telephone Lead-In Pipes 230 255 0 127 

TV Antenna System, Cable TV System (TV Pt., 
Data Pt., Tele Pt. Etc...) 131 170 255 255 

Revision Cloud 50 255 255 0 

Electrical Lead-In Pipe/ Underground Cables 
(Hidden Line Type) 2 255 255 0 
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PROTECTION, PLUMBING, SANITARY & GAS  
 

SYSTEM TYPE COLOR RED GREEN BLUE 

Fire Protection Pipe 241 255 170 191 

Fire Protection Concealed Pipe 134 0 129 129 

Fire Protection Exposed Pipe 231 255 170 212 

Sanitary SWP 240 255 0 63 

Sanitary WP 240 255 0 63 

Vent 94 0 129 0 

Domestic Cold Water Booster Pipe 214 129 0 129 

Domestic Cold Water Gravity Pipe 240 255 0 63 

Domestic Cold Water Transfer Pipe 230 255 0 127 

Domestic Hot Water Booster Pipe 214 129 0 129 

Domestic Hot Water Gravity Pipe 240 255 0 63 

Domestic Hot Water Return Pipe 30 255 127 0 

NEWater Water Booster Pipe 214 129 0 129 

NEWater Water Gravity Pipe 240 255 0 63 

NEWater Water Transfer Pipe 230 255 0 127 

Plumbing Annotation 51 255 255 170 
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